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1. Tổng quan về Microsoft Powerpoint 

Microsoft Powerpoint là một phần mềm nằm trong bộ phần mềm văn phòng Microsoft Office 

nổi tiếng do hãng Microsoft sản xuất. Microsoft PowerPoint là công cụ tuyệt vời giúp người 

sử dụng có được hiệu quả cao khi trình bày. Một số ưu điểm của phần mềm Microsoft 

Powerpoint: 
 

+ được thiết kế thống nhất về thao tác nhập và chỉnh sửa các đối tượng như văn bản, 

hình ảnh, bảng biểu nên những người đã thành thạo với Microsoft Word không phải 

học thêm nhiều thao tác mới. 
 

+ ngoài các đối tượng cơ bản đã sử dụng trong Microsoft Word, phương tiện âm thanh, 

hiệu ứng động, các đoạn phim được hỗ trợ làm cho bài trình bày trở nên sinh động. 

Những ý tưởng được diễn tả qua hình ảnh luôn được đánh giá cao. 
 

Một bài trình diễn tạo ra bởi Microsoft Powerpoint bao gồm nhiều trang trình diễn (tiếng Anh 

gọi là Slide). Có thể tóm tắt các giai đoạn thực hiện như sau: 
 

+ Khởi tạo một bài trình diễn. Lưu bài trình diễn lên đĩa. 
 

+ Khởi tạo trang trình diễn. Nhập/chỉnh sửa nội dung trên trang. Tạo thêm/sao chép/ 

sắp xếp trang. Lưu bài trình diễn lên đĩa. 
 

+ Tạo hiệu ứng trình diễn cho các đối tượng trên trang. Lưu bài lên đĩa. 
 

+ Trình diễn thử bài làm. 
 

+ In bài trình diễn ra giấy. 
 

 

2. Khởi động Microsoft Powerpoint 

Cách khởi động PowerPoint chính tắc nhất là như sau: 
 

 Kích chuột menu Start của Windows nằm ở góc trái dưới màn hình 

 Kích chọn tuỳ chọn Programs 

 Kích vào Microsoft Office để chọn Microsoft Office Powerpoint 
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3. Tạo bài trình diễn mới 
 

3.1 Tạo bài trình diễn mới ngay sau khi khởi động PowerPoint 

Sau khi khởi động PowerPoint, để tạo ra một bản trình diễn mới, 

kích chọn nút radio , rồi kích OK. 
 

 

 

 
3.2 Tạo bài trình diễn mới khi đang sử dụng PowerPoint 

 

 
 

3.3 Chọn bố cục trình bày trang trình diễn (Slide) 

Mỗi Slide trong PowerPoint có thể có một kiểu bố cục trình bày riêng. Bố cục tức là cách 

bố trí các khối văn bản, hình ảnh, đồ thị... trong Slide. Trước khi soạn thảo nội dung của mỗi 

Slide, tuỳ theo nội dung trình diễn và sở thích, người dùng phải chọn một kiểu bố cục trong 

danh sách kiểu bố cục có sẵn của PowerPoint như sau: 
 

 

 Danh sách các kiểu bố cục Slide 

1.Kích 

chọn một 

kiểu bố 

cục 

2. Kích 

chọn OK 

Tên của kiểu bố 

cục được chọn 

Kích nút New 

trên thanh 

công cụ chuẩn 



P-5  

3.4 Làm quen với giao diện chương trình 
 

 
 

3.5 Chuyển khung nhìn soạn thảo 

Các trang bài trình diễn được hiển thị theo nhiều khung nhìn khác nhau phù hợp với những 

yêu cầu khi soạn thảo và khi trình diễn. 
 

Cách thực hiện: 
 

Cách thứ 1: Bấm nhanh vào nút chuyển ở góc dưới bên trái của cửa sổ chương trình. 

Cách thứ 2: Vào thanh lệnh View, chọn cách thức hiển thị các trang trình diễn. 

 

 

Lưu ý: Khi muốn hủy bỏ một trạng thái hay một tiến trình đang xảy ra chỉ cần bấm phím 

ESC. Ví dụ bấm chọn mục Slide Show, sau đó bấm phím ESC thì chương trình quay trở 

lại khung soạn thảo. 
 

4. Lưu bài trình diễn lên đĩa, mở bài trình diễn đã có trên đĩa 
 

4.1 Lưu 1 bài trình diễn lên đĩa 
 

 

Nút Save trên thanh 

công cụ chuẩn 

Thanh 

Menu 

Thanh 

công cụ 

chuẩn 

Gõ tiêu đề 

của Slide 

vào ô này 

Cửa sổ 

soạn 

thảo 

từng 

Slide 

Thanh 

công 

cụ định 

dạng 

Cửa sổ Layout 

cho cái nhìn tổng thể 

về toàn bộ các Slide Gõ nội dung của 

Slide vào ô này 

Các nút 

chuyển 

khung 

nhìn 

Thanh trượt 

Cửa sổ ghi chú 
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Nếu là lần đầu tiên ghi lên đĩa, thì cần phải chọn thư mục chứa tệp và đặt tên cho tệp trình 

diễn. Thông thường tên tệp trình diễn tạo bởi Microsoft Powerpoint có dạng tổng quát là: 

<tên_chính>.ppt, trong đó tên_chính do người soạn thảo tự đặt, còn phần đuôi .ppt do 

chương trình tự gán thêm vào. 
 

 

 
 

Giải thích thêm 
 

+ Nút (1), (2) là các nút tiện ích để di chuyển nhanh đến các vị trí thư mục trên đĩa. 
 

+ Nút (3) sử dụng khi muốn tạo thư mục mới chứa tệp trình diễn 
 

4.2 Đóng cửa sổ bài trình diễn đã soạn: 
 

 
 

Thao tác với thanh lệnh: 
 

+ Vào thanh lệnh FILE, chọn mục CLOSE. 

Bấm nút này 

để đóng bài 

trình diễn đã 

soạn 

sử dụng để 

chuyển đến 

thư mục mẹ 

của thư mục 

hiện hành 

nút tạo thư 

mục mới 
Chọn nhanh 

thư mục 

trên đĩa 

Nút Save để thực hiện 

việc ghi lên đĩa 
nơi gõ tên tệp 
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4.3 Mở một bài trình diễn đã có trên đĩa 
 

 

 
 

 
 

5. Tạo bài trình diễn theo kịch bản có sẵn 
 
5.1 Sử dụng công cụ AutoContent Wizard 

Có nhiều cách thức khởi tạo bài trình diễn nhưng để tiện thao tác khi thực hành trong tài liệu 

chỉ nêu một cách chuẩn mực nhất và yêu cầu đóng tất cả các bài trình diễn đang soạn thảo. 
 

Các bước thực hiện: 
 

+ Vào thanh lệnh FILE, chọn mục NEW. Trong hộp thọai xuất hiện chọn AutoContent 

Wizard. 

Chuyển đến 

thư mục chứa 

tệp 

chọn tệp 

muốn mở 

bấm nút 

Open để 

mở tệp 

Kích nút Open trên 

thanh công cụ chuẩn 
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+ Trong các hộp thoại tiếp theo chọn lựa mục Next cho đến khi gặp nút Finish. 
 

 

6. Thao tác với trang soạn thảo 
 
6.1 Tạo mới/ chỉnh sửa/sao chép/di chuyển/xóa bỏ trang 

Các trang của bài trình diễn được phép tạo mới/ chỉnh sửa/sao chép/ di chuyển/ xóa bỏ chỉ có 

thể thực hiện khi làm việc trên các khung nhìn : 
 

(1) Normal View (2) Outline View (3) Slide View (4) Shorter View 

và không thực hiện được khi đang ở Slide Show. 

Đối với khung nhìn Normal View 
 

 

chọn trang và thao tác sao chép 

bằng nút công cụ COPY và 

PASTE 
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+ Thao tác chọn: 
 

- dùng phím và chuột máy tính để chọn một trang ở cửa sổ bên trái. 
 

- muốn chọn nhiều trang liên tục, bấm chọn trang đầu tiên, giữ phím Shift và bấm 

chọn trang cuối. Chú ý không chọn được các trang rời rạc trong khung nhìn Normal. 
 

- muốn xóa bỏ đánh dấu chọn trên các trang đã thực hiện chỉ cần bấm phím chuột 

vào vùng bất kỳ của cửa sổ soạn thảo. 
 

+ Thao tác sao chép: cần phải chọn trang trước khi sao chép và thao tác tiếp theo nhu sau: 
 

- bấm nút COPY hoặc nhấn tổ hợp phím Ctrl-C. Sau đó nhấn nút PASTE hoặc nhấn 

tổ hợp phím Ctrl-V. 
 

+ Thao di chuyển trang: chọn trang và thao tác tiếp theo như sau: 
 

- bấm chọn nút biểu diễn trang và kéo lên trên hoặc xuống dưới. 
 

+ Thao tác xóa trang: chọn trang và thao tác tiếp theo như sau: 
 

- nhấn nút DELETE. 
 

Đối với khung nhìn Slide Sorter View 
 

 
 

Các thao tác được thực hiện tương tự như trong khung Normal View. Có bổ sung thêm 

thao tác như sau: 
 

+ Chọn nhiều trang rời rạc: 
 

- muốn chọn nhiều trang rời rạc, bấm chọn trang đầu tiên, giữ phím Ctrl và bấm chọn 

từng trang tiếp theo. 
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+ Chèn thêm một trang mới : Vào thực đơn Insert, chọn New Slide. Trong trường hợp 

đã chọn một trang và muốn sao chép trang đó thành trang mới thì chọn Duplicate 

Slide. 
 

 

 
 

6.2 Đặt mẫu thiết kế chung (temlate) cho các trang 

Chuyển trang về khung nhìn Normal View. 
 

 

 
 

 

 

Hình xem trước 

của template đã 

chọn 

3. Kích chọn 

một template 

có sẵn 

Danh 

sách các 

template 

có sẵn Nút Apply 

để áp dụng 

template đã 

chọn 

Chọn 

Apply Design Template 
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6.3 Soạn thảo và định dạng nội dung 

Việc soạn thảo nội dung cho trang chỉ thực hiện được trên khung Normal View, Outline View 

và Slide View. Từ các khung khác có thể dễ dàng chuyển về ba khung trên bằng nút chuyển. 
 

Trong màn hình soạn thảo, vùng soạn thảo được bao bọc bởi các đường chấm chấm. Vùng 

trên cùng là vùng dành cho tiêu đề, các vùng còn lại dành cho ý tưởng cần trình bày. 
 

Nội dung văn bản do người dùng nhập vào được phân thành 5 mức khác nhau, mỗi mức có 

thể có một tập các định dạng riêng (phông chữ, căn lề, màu chữ, kiểu gạch đầu dòng...) tuỳ 

theo mẫu template được chọn. Việc soạn thảo văn bản tuân theo những qui cách cơ bản được 

sử dụng trong Microsoft Word. 
 

Một tính chất rất quan trọng của trang trình diễn là các dòng văn bản được soạn thảo luôn gắn 

liền với các đối tượng hình ảnh, bảng biểu. 
 

 

6.3.1 Thay đổi Slide Layout (kiểu dạng trang) 

 

 
 

 

6.3.2 Soạn nội dung cho các đối tượng chuẩn 

Sau khi chọn Slide Layout, các đối tượng chuẩn của trang được xuất hiện với các dòng thông 

báo như " Click to add text". Chỉ cần bấm đúp chuột vào các đối tượng để chuyển đối tượng 

sang trạng thái nhập nội dung. 
 

 
 

Nội dung soạn trong các đối tượng chuẩn được quản lý và thể hiện trong cửa sổ Layout ở bên 

trái màn hình. 

Một Text Box thuộc đối 

tượng chuẩn của Slide 

Layout 

Chọn Format trên thanh lệnh 

Chọn Slide Layout 
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6.3.3 Chèn thêm Text Box 

Ngoài các Text Box thuộc đối tượng chuẩn, người sử dụng có thể chèn thêm các Text Box 

khác vào trang trình diễn bằng cách: 
 

 
 

Trên thanh công cụ Drawing, chọn nút Text Box. Di chuyển chuột vào vùng soạn thảo kéo 

một hình chữ nhật, sau đó gõ văn bản vào trong hình chữ nhật đó. 
 

 
 

Các nút định dạng trên thanh công cụ Drawing cho Text Box: 

 
 

 

 

 

Thao tác với Font Color 
 

+ Chọn các dòng chữ trong Text Box (bôi đen văn bản như đã làm trong Microsoft Word) 
 

+ Sau đó bấm chọn nút Font Color để áp dụng màu đã có cho chữ được chọn hoặc bấm 

vào mũi tên chọn màu mới cho chữ được chọn. 
 

Thao tác với Line Color 
 

+ Bấm chọn đối tượng Text Box bằng cách bấm vào đường viền của đối tượng. 
 

+ Bấm chọn màu đã có trong mục Line Color hoặc bấm vào mũi tên chọn màu mới cho 

đường viền.. 

dùng để dạng ba 

chiều cho chữ 

hoặc hình ảnh 

Fill Color, dùng 

để định dạng nền 

Line Color, dùng 

để định dạng 

đường viến 

Font Color, dùng 

để định dạng chữ 

dùng để tạo bóng 

cho chữ hoặc 

hình ảnh 

Bấm chọn nút Text Box 
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Thao tác với Fill Color 
 

+ Chọn đối tượng Text Box 
 

+ Bấm nút Fill Color trên thanh công cụ làm xuất hiện hộp thọai. 
 

 
 

+ Chọn mục Fill Effects làm xuất hiện cửa sổ Fill Effects 
 

 
 

Trong trang Gradient có thể chọn lựa các cách hòa màu: One Color, Two Colors, Preset. Phần 

Shading Styles cho phép chọn lựa các kiểu dáng hòa màu. Bấm chọn mẫu màu trong phần 

Variants và chọn Preview để xem trước mẫu màu được áp dụng cho đối tượng Text Box. Cuối 

cùng bấm chọn OK nếu đồng ý áp dụng, bấm nút Cancel để hủy bỏ những thao tác đã làm. 
 

 

6.3.4 Chèn thêm chữ nghệ thuật 

+ Bấm chọn nút WordArt trên thanh công cụ Drawing làm xuất hiện hộp thọai tạo chữ 

nghệ thuật. 
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+ Bấm chọn mẫu sọan chữ làm xuất hiện cửa sổ nhập nội dung: 
 

 
 

Chọn phông chữ thích hợp để gõ nội dung (chọn phông TCVN3 để gõ nội dung tiếng Việt). 
 

+ Sử dụng thanh công cụ WordArt để chỉnh sửa nội dung 
 

 
 

 

 

6.4 Sử dụng các nút tiện ích trên thanh công cụ 
 

 

Tiện ích 

UNDO 

Tiện ích 

REDO 

Hiển thị đầy 

đủ hay thu 

gọn phần nội 

dung 

Tạo trang 

mới 

Hiển thị 

định dạng 

chữ Việt 

tăng/ giảm 

độ lớn 

khung nhìn 

chỉnh sửa 

nội dung 

tạo dáng 

mới 

đảo chiều xoay chữ 
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6.4.1 Định dạng về chữ và nền 
 

 

 
 

 

Lưu ý: Các thay đổi định dạng (phông chữ, màu nền...) chỉ có tác dụng trên đối tượng văn 

bảng được chọn của trang hiện thời, không ảnh hưởng tới các Slide khác. 
 

6.4.2 Thay đổi phông chữ, cỡ chữ, kiểu chữ: 

 

 
 

 

 

Kích vào đây 

để đổi phông 

chữ khác 
Kích vào đây 

để thay đổi cỡ 

chữ 

Nút đưa vào hoặc xoá 

bỏ các dấu gạch đầu 

dòng 

Nút khôi 

phục trạng 

thái cũ 

Nút tăng 

giảm, cỡ chữ Nút sao chép 

định dạng 

Các nút thay đổi 

dạng chữ 

Nút tạo 

bóng chữ 
Nút căn lề chữ 
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6.4.3 Thay đổi kiểu đánh số hoặc gạch đầu dòng 

 

 
 

 

 

 
 

7. Chèn ảnh vào trang 
 
7.1 Chèn ảnh từ Clipart 

Clipart là bộ sưu tập ảnh phân loại theo chủ đề, có sẵn trong Microsoft Powerpoint. 
 

Để chèn ảnh từ Clipart, làm như sau: 
 

 

 

3. Kích chọn 

Clipart 1. Kích chọn 

Insert 

5. Kích chọn 

ảnh cần chèn 

2. Kích chọn 

Picture 

6. Kích chọn nút 

Insert clip để kết 

thúc việc chèn ảnh 

Chọn 

Bullets and Numbering 
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7.2 Chèn ảnh từ tệp đã có sẵn trên thư mục 

Nếu đã có một tệp ảnh trên đĩa thì có thể chèn ảnh đó vào trang. 

Cách thực hiện: 

+ Vào thanh lệnh Insert, chọn Picture --> From File. 
 

 

 
 

+ Chọn tệp cần chèn trong thư mục trên máy. Bấm chọn Insert để kết thúc. 
 

 
 

7.3 Chèn hình ảnh từ mục AutoShape 

Trên thanh công cụ Drawing có hỗ trợ sẵn các đối tượng hình cơ bản như: hình chữ nhật, hình 

Elip, đường thẳng,.. Ngoài ra thư viện các hình khác rất phong phú được cung cấp trong mục 

AutoShapes. 
 

 

Chọn tệp cần 

chèn 

Kích chọn 

thư mục 

chứa tệp 
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Thao tác chèn mũi tên 
 

+ Chọn hình mũi tên sang phải trong nhóm các hình Block Arrows 
 

 
 

 

+ Kích nút chuột phải vào mũi tên và chọn mục Add Text để chèn thêm dòng chữ như hình 

minh họa. 
 

Ngoài ra có thể chèn hình chữ nhật, hình Elip, đường thẳng theo các nút sẵn có trên thanh 

công cụ Drawing. 
 

 
 

 

7.4 Thay đổi các định dạng nền 

Có thể làm thay đổi màu hoặc kiểu hoa văn trang trí nền của các trang và các đối tượng có 

mặt trên trang như sau: 
 

 

 
 Thay đổi màu nền: 

 

 

Nút Apply để 

hoàn tất việc 

thay đổi 

Kích vào 

đây để thay 

đổi nàu nền 

Chọn ngay các màu đang hiển thị 

hay để chọn thêm màu nền ở đây 

Chọn mục 

Background 
Mục Format trên 

thanh Menu 

mũi tên sang phải 
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 Thay đổi màu sắc và hoa văn: 
 

 
 

 
 

7.5 Một số thao tác đối với ảnh 

 Nhóm (group) các đối tượng hình ảnh: bấm chọn các đối tượng, kích nút phải chuột để 

xuất hiện hộp lựa chọn. Chọn mục Group để nhóm các đối tượng thành một đối tượng. 

Chọn Ungroup để phá bỏ nhóm đã tạo. Việc nhóm các đối tượng ảnh rất cần thiết khi 

muốn thao tác đồng thời trên nhiều đối tượng hình ảnh. 
 

 
 

 

 Thay đổi kích thước của ảnh sau khi chèn: kích chọn ảnh, định vị chuột vào các nút điều 

khiển kích thước ảnh, nhấn & giữ phím chuột trái, rồi kéo rê chuột theo các hướng sao cho 

đạt được kích thước mong muốn (kéo rê chuột vào phía trong ảnh sẽ thu nhỏ ảnh, kéo rê 

chuột ra phía ngoài sẽ phóng to ảnh) 

Kích vào thẻ Texture hoặc 

Pattern để chọn các hoa 

văn nền 

Kích vào thẻ 

Gradient   để chọn 

cách tô màu nền 

Chọn nút OK 

để hoàn tất 

việc thay đổi 

Kích vào 
đây để thay 

đổi hoa văn 

nền 
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 Dịch chuyển ảnh: kích chọn đối tượng ảnh, định vị chuột vào trong ảnh, nhấn & giữ phím 

chuột trái, rồi kéo rê đến vị trí mong muốn. 

 Xoá ảnh: kích chọn đối tượng hình ảnh, ấn phím Delete. 

 Sao chép/cắt dán ảnh: chọn đối tượng hình. Sau đó thao tác với nút COPY (hay Ctrl+C). 

Thực hiện dán hình ảnh bằng nút PASTE (hay Ctrl-V). 

 Đặt thuộc tính cho ảnh: Hình ảnh có thể đặt trên / hoặc dưới văn bản bằng cách đặt thuộc 

tính: Bring to Front, Send to Back,... 
 

 

 

8. Chèn bảng biểu vào trang 
 
8.1 Cách chèn bảng biểu 

Chọn Insert -> Table trên thanh lệnh. Trong hộp Insert Table chọn số cột và dòng. 
 

 

 
 

8.2 Soạn thảo bảng 

 Kích chuột vào các ô cần soạn thảo, gõ văn bản 

 Để thay đổi kích thước các hàng, cột: định vị chuột vào các đường biên rồi kích và giữ 

phím chuột trái, rê chuột sang trái, phải, lên trên xuống dưới cho đến khi đạt được kích 

thước mong muốn 

 Để thêm một hàng: kích chuột phải vào vị trí hàng cần thêm, chọn Insert Rows 

 Để xoá một hàng: bôi đen hàng cần xoá, kích chuột phải lên vùng bôi đen, chọn Delete 

Rows 

1. Điền số 

cột vào đây 3. Kích 

OK để 

kết thúc 

2. Điền số 

hàng vào đây 

các nút điều 

khiển kích thước 

ảnh 
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 Để thêm 1 cột: bôi đen 1 cột tại vị trí cần chèn, kích chuột phải vào vùng bôi đen, chọn 

Insert Columns 

 Để xoá một cột: bôi đen cột cần xóa, kích chuột phải lên vùng bôi đen, chọn Delete 

Columns 

 Xoá dữ liệu trong bảng: bôi đen phần dữ liệu cần xoá, ấn phím Delete 

 Để nhập một số ô thành một ô: bôi đen các ô cần nhập, kích chuột phải vào vùng bôi 

đen, chọn Merge Cells 

 Để phân tách 1 ô thành 2 ô: 

· Mở thanh công cụ Tables & Borders: chọn View -> Toolbars -> Tables & Borders 

· Chọn ô cần phân tách, bấm nút Split Cell trên thanh công cụ 
 

 
 

 Các nút chức năng khác của thanh công cụ Tables & Borders: 
 

 
 

 Để xoá toàn bộ bảng: Chọn bảng sau đó bấm vào nút CUT. 
 

 Để dịch chuyển toàn bộ bảng có thể sử dụng chuột bấm chọn đường biên của bảng và 

kéo đến vị trí mới. 
 

 Để thay đổi kích thước của bảng: kích chuột trái vào bảng, tám nút điều khiển kích 

thước xuất hiện trên các đường biên ngoài cùng. Điều khiển các nút để đạt được kích 

thước mong muốn. 
 

 

8.3 Sử dụng thanh công cụ Tables and Boders 

Để hiển thị thanh công cụ, vào thanh lệnh View, chọn Toolbars--> Tables and Borders. Việc 

che dấu thanh công cụ cũng được thực hiện tương tự. 
 

 

8. Nút dùng nhập 

các ô thành 1 ô 
5. Nút dùng 

thay đổi màu 

của đường biên 

6. Nút dùng chỉ định 

vẽ hay không  vẽ 

một số đường biên 

2. Nút dùng 

xoá các 

đường biên 

3. Nút dùng 

thay đổi kiểu 

đường biên 

1. Nút dùng 

kẻ các 

đường biên 

4. Nút dùng thay 

đổi độ dày của 

đường biên 

9. Ba nút căn lề trên, 

căn giữa, căn lề dưới 

văn bản trong ô 

Nút Merge Cell Nút Split Cell 
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 Các phần tử của đồ thị: 

2. Chart 

Title 
13. Wall 

14. Data 

Label 11. Z Axis 
1. Chart 

area 

12. Z Axis 

Title 3. Legend 
16. Tick 

Mark Label 

4. Data 

Series 
9. Plot Area 

9. Chèn đồ thị vào trang 
 
9.1 Chèn đồ thị 

 Kích chọn nút Insert Chart trên thanh công cụ chuẩn (hoặc chọn Insert -> Chart trên 

thanh menu) 
 

 
 

 Đồ thị và bảng số liệu mặc định tương ứng hiện ra. Có thể sửa các số liệu trên bảng số 

liệu mặc định bằng cách kích chuột vào các ô số liệu của bảng và gõ số liệu mới. Đồ 

thị sẽ thay đổi tương ứng theo các số liệu mới. 
 

 

9.2 Chỉnh sửa đồ thị 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

10. Gridline 8. X 15. Floor 7. X Axis 6. Major 5. Minor 

 Axis  Title Tick Mark Tick Mark 

 

 
 

 

1. Chart Area: Vùng nền ngoài cùng của đồ thị. Thông thường vùng này được 

dùng để chứa tiêu đề (Chart Title) & chú thích (Legen) của đồ thị. 

2. Chart Title: Tiêu đề của đồ thị. 

3. Legen: Chú thích của đồ thị. 

4. Data Series: Biểu diễn các hạng mục dữ liệu chủ yếu trong đồ thị, ví dụ trong 

đồ thị trên là các cột. Số các hạng mục (Data Series) bằng số các cột khác màu 

được ghi trong phần chú thích của đồ thị, ví dụ trong đồ thị trên số các Data 

Series là 3 bao gồm: Toán, Lý, Hoá. 

5. Minor Tick Mark: Các vạch chia chính trên trục toạ độ. 

6. Major Tick Mark: Các vạch chia phụ trên trục toạ độ. 

7. X Axis Title: Tiêu đề của trục X. 

Nút Insert Chart 
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8. X Axis: Trục X. 

9. Plot Area: Vùng nền để vẽ đồ thị chứa các phần tử chính của đồ thị như: Tiêu 

đề các trục toạ độ, các trục toạ độ, đồ thị, lưới ... 

10. Gridline: Lưới đồ thị, là những đường song song với các trục toạ độ giúp 

người xem dễ hiểu hơn. Có 2 loại đường lưới: đường lưới chính và đường lưới 

phụ. 

11. Z Axis: Trục Z hay còn gọi là trục giá trị. 

12. Z Axis Title: Tiêu đề của trục Z. 

13. Wall: Nền lưới đồ thị. 

14. Data Label: Phần nhãn của dữ liệu, được biểu hiện trên đồ thị bằng các chỉ số 

giá trị trên các cột. 

15. Floor: Phấn nền chân và mặt bên của đồ thị 3 chiều. 

16. Tick Mark Label: Nhãn dữ liệu ghi trên trục X, thông thường là các nhãn cột 

trong bảng dữ liệu của đồ thị. 
 

 Thay đổi kích thước của đồ thị, dịch chuyển đồ thị: kích đơn chuột trái vào đồ thị để 

chọn đồ thị, sau đó làm các bước tương tự như đối với ảnh. 

 Thay đổi kiểu đồ thị: Microsoft Powerpoint cung cấp rất nhiều các kiểu đồ thị khác nhau. 

Với mỗi kiểu lại có một số các kiểu con tương ứng với nó. Để thay đổi kiểu đồ thị, làm 

như sau: 

 Kích đúp chuột trái trên đồ thị để chuyển sang trang thái soạn thảo đồ thị. 

 Kích đơn chuột phải lên vùng Chart Area hoặc Plot Area, chọn Chart Type 
 

 
 

 

 Trong cửa sổ chọn kiểu đồ thị làm như sau: 
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 Đưa vào tiêu đề đồ thị, tiêu đề cho các trục toạ độ: 

 Chuyển đồ thị sang trạng thái soạn thảo bằng cách kích đúp chuột vào đồ thị. 

 Kích đơn chuột phải vào vùng Chart Area hoặc Plot Area, chọn Chart Option. Thực 

hiện các bước như hình minh họa: 
 

 

1. Chọn thẻ 

Titles 2. Gõ tiêu 

đề đồ thị 

vào đây 
3. Gõ 

tiêu đề 

trục X 

vào đây 5. Nhấn nút OK 

để kết thúc 

4. Gõ tiêu đề 

trục Z vào đây 

1. Chọn thẻ 

Standard 

Types 

2. Chọn 

kiểu đồ thị 

mới 

3. Chọn kiểu 

đồ thị con 

4. Chọn OK 

để kết thúc 
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 Hiển thị hoặc che dấu các đường lưới đồ thị: 
 

 
 

 Lưu ý: đối với các hộp kiểm tra, nếu đã có dấu kiểm tra, ví dụ , có nghĩa 

là sẽ hiển thị phần tử được chọn (đường lưới phụ). Nếu kích chuột 1 lần nữa, dấu kiểm 

tra sẽ biến mất:  tức là không hiển thị phần tử được chọn nữa. 

 Hiển thị hoặc không hiển thị chú thích đồ thị: 
 

 

2. Kích vào 

đây để hiện 

hoặc xoá 

chú thích 

1. Chọn 

Thẻ Legend 

3. Kích chọn vị trí cho chú 

thích: 

- 

- 

- 

- 

- 

Bottom: phía dưới đồ thị 

Corner: góc trên bên phải 

Top: phía trên đồ thị 

Right: bên phải đồ thị 

Left: bên trái đồ thị 

2. Kích vào 

đây để hiện 

các đường 

lưói chính 

trục X 
1. Chọn thẻ 

Gridline 

4. Kích vào 

đây để hiện 

các đường 

lưói chính 

trục Z 

3. Kích vào đây 

để hiện các đường 

lưói phụ trục X 

5. Kích vào đây 

để hiện các 

đường lưóiphụ 

trục Z 

6. Kích 

OK để 

kết thúc 
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 Đưa vào các nhãn dữ liệu (Data label): 
 

 
 

 

 Xoá các phần tử không cần thiết của đồ thị: kích đơn chuột phải vào phần tử đồ thị 

muốn xoá, chọn Clear. 

 Thay đổi vị trí của 1 phần tử đồ thị: Kích chuột trái vào phần tử, giữ & kéo rê chuột đến 

vị trí mới. Các phần tử sau có thể thay đổi được vị trí: tiêu đề, chú thích, nhãn dữ liệu, Plot 

Area. 
 

 

 Đóng và mở bảng số liệu tương ứng với đồ thị: 

 Mở bảng số liệu: kích chuột phải vào vùng Plot Area hoặc Chart Area, chọn Datasheet. 

 Đóng bảng số liệu: 
 

 
 

 

 Định dạng cho các phần tử của đồ thị: Khi đồ thị đang ở chế độ soạn thảo (kích đúp vào 

đồ thị để chuyển sang chế độ soạn thảo), kích đúp vào 1 phần tử cần làm định dạng (chẳng 

hạn Plot Area). Cửa sổ định dạng cho phần tử đó có các thẻ định dạng như: Font để thay 

đổi kiểu font chữ, Pattern để thay đổi màu viền, hoa văn nền, màu nền, Alignment để thay 

đổi hướng chữ... Sau đây là một số kiểu định dạng: 

Kích chuột 

vào đây để 

đóng bảng 

số liệu 

1. chọn thẻ 

Data Labels 

2. Chọn nút 

Show value 
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Thao tác định dạng này có thể áp dụng cho hầu hết các phần tử đồ thị. Riêng các trục 

toạ độ và lưới không có định dạng về nền. 

5. Chọn màu 

nền 1. Chọn 

thẻ Pattern 2. Chọn kiểu 

viền 

3. Chọn 

màu viền 

6. Chọn 

hoa văn 

nền 4. Chọn 

bóng 

cho viền 3. Chọn độ 

dày cho viền 

3. Chọn dạng chữ 
1. Chọn 

thẻ Font 4. Chọn 

cỡ chữ 

2. Chọn 

font chữ 

5. Chọn 

màu chữ 

6.  Kích  OK 
để kết thúc 
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Thay đổi hướng chữ: 
 

 

 
 

 

 

10. Chèn sơ đồ tổ chức vào trang 

Sơ đồ tổ chức là sơ đồ phân cấp hình cây từ trên xuống dưới. Các thành phần của sơ đồ 

bao gồm: tiêu đề của sơ đồ, các nút sơ đồ, đường nối giữa các nút, nền sơ đồ. Sau đây là một 

ví dụ mô tả các thành phần của sơ đồ: 
 

 

Chọn thẻ 

Alignment 

Kích nút OK 

để kết thúc 
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10.1 Tạo sơ đồ tổ chức bằng các hình sẵn có 

Sử dụng các hình dạng được hỗ trợ sau: 
 

+ Hình chữ nhật: 
 

 
 

 

+ Hình Elip: 
 

 

 

+ Các đường thẳng, đường mũi tên và các hình sẵn có trong Autoshapes. 
 

 

10.2 Tạo sơ đồ tổ chức bằng công cụ tự động 

 Chọn Insert -> Picture -> Organization Chart như sau: 
 

 
 Màn hình soạn thảo sơ đồ gồm 1 sơ đồ mặc định (có 4 nút chia thành 2 mức) hiện ra. 

Mỗi nút có 4 hàng có thể gõ văn bản vào như sau: 
 
 

 

Hàng thứ 2       

Hàng thứ 4        

    Hàng thứ nhất 

 
    Hàng thứ 3 

· Để gõ văn bản vào nút sơ đồ, kích chuột vào nút đó và gõ văn bản. 

· Lưu ý: đối với 2 hàng đầu, nếu bạn không gõ văn bản vào thì cần phải xoá 2 hàng 

chữ mặc định tương ứng nếu không muốn chúng hiện ra. 
 

 

10.3 Nhập tiêu đề sơ đồ 

Bôi đen dòng chữ “Chart Title” trên đỉnh sơ đồ, rồi gõ nội dung tiêu đề. 
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10.4 Chèn thêm các nút sơ đồ 

 Trước khi thực hiện đưa thêm một nút vào đồ thị cần: 

· Xác định một nút làm mốc trong trong sơ đồ. 

· Sau đó xác định vị trí tương đối của nút mới so với nút làm mốc. Có 5 vị trí tương 

đối có thể có: nút mức trên, nút mức dưới, nút cùng mức bên trái, nút cùng mức bên 

phải, nút trung gian. 

 Thao tác đưa thêm 1 nút mới vào sơ đồ như sau: kích chuột vào một nút công cụ 

(tương ứng với vị trí tương đối của nút mới) trên thanh công cụ của màn hình (xem 

hình sau), sau đó kích chuột vào nút làm mốc trên sơ đồ. 
 

 

 

 
 

 

10.5 Các thao tác khác 

Thao tác chọn: 

 Chọn 1 nút sơ đồ: kích vào nút đó. 

 Chọn một nhóm các nút sơ đồ: 

· Rê chuột vẽ 1 hình chữ nhật bao trọn các nút muốn chọn. 

· Nếu các nút muốn chọn không thể nằm trong 1 hình chữ nhật, nhấn & giữ phím 

Shift, đồng thời kích chuột vào các nút muốn chọn. 

· Chọn toàn bộ các nút sơ đồ: bấm Ctrl + A. 

 Thao tác chọn các đường nối giữa các nút làm tương tự như với các nút 

· Chọn toàn bộ các đường nối: kích chuột phải trên phần nền màn hình soạn thảo 

(phần trống không có vẽ sơ đồ), chọn Select -> Connecting Lines 
 

 
 

 

 

Xoá 1 nút hoặc 1 nhóm nút: 

 Kích chọn nút hoặc nhóm nút đó, bấm phím Delete. 

Kích vào đây 

để đưa vào 

nút mức dưới 

Kích vào đây để 

đưa vào nút cùng 

mức bên trái 

Kích vào đây để 

đưa vào nút cùng 

mức bên phải 

Kích vào đây 

để đưa vào 

nút mức trên 

Kích vào đây 

để đưa vào 

nút trung gian 
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Thay đổi kiểu dáng sơ đồ: 

 Có thể thay đổi kiểu dáng của 1 phần hoặc toàn bộ sơ đồ 

 Thao tác: 

+ Chọn toàn bộ hoặc 1 phần sơ đồ 

+ Trên thanh Menu chọn Styles, sau đó kích chọn kiểu dáng trong danh sách 
 

Thay đổi phông chữ, kiểu chữ, kích thước chữ: 

 Chọn các nút muốn thay đổi 

 Chọn Text -> Font trên thanh Menu 

 Sau đó làm các bước như trong hình minh họa. 
 

 

 

Thay đổi màu chữ: 

 Chọn các nút muốn thay đổi. 

 Chọn Text -> Color trên thanh lệnh. 

 Kích đúp vào màu muốn chọn trong bảng màu. 
 

 

Thay đổi màu nền và viền của nút: 

 Chọn các nút muốn thay đổi. 

 Kích chuột phải lên một nút. 

 Sau đó làm theo các bước sau đây: 
 

 
 

Thay đổi định dạng của các đường nối: 

 Chọn các đường nối muốn thay đổi 

 Kích chuột phải trên 1 đường nối đã chọn 

1. Thay đổi 

màu nền 2. Thay đổi 

kiểu bóng 

3. Thay đổi 

kiểu viền 4. Thay đổi 

màu viền 

5. Thay đổi kiểu 

liền nét, đứt 

quãng của viền 

1. Chọn phông 

chữ ở đây 2. Chọn kiểu 

chữ ở đây 

3. Chọn cỡ 

chữ ở đây 

4. Chọn OK 

để kết thúc 
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Thay đổi màu nền sơ đồ: 

 Kích chuột phải lên vùng nền trống của sơ đồ 

 Chọn Background Color 

 Kích đúp vào màu muốn chọn trong bảng màu để quay về màn hình soạn thảo Slide 

 Sau khi đã soạn thảo hoàn chỉnh sơ đồ, để quay về màn hình soạn thảo Slide, kích vào 

nút đóng cửa sổ soạn thảo sơ đồ  (góc trên bên phải cửa sổ). 

 Trong hộp thoại Microsoft Organization Chart, chọn Yes 
 

 
 

 

 Trong màn hình soạn thảo Slide, sơ đồ tổ chức được coi như một đối tượng đồ họa, 

cac thao tác dịch chuyển, phóng to, thu nhỏ, xoá làm hoàn toàn tương tự như đối với 1 

bức ảnh. 

 Từ màn hình soạn thảo Slidse, muốn soạn thảo sơ đồ, chỉ cần kích đúp chuột vào sơ đồ 
 

 

11. Thiết lập các hiệu ứng động (animation) 
 
11.1 Hiệu ứng động cho các thành phần 

Một tính năng được nhiều người dùng ưa chuộng trong các bài trình diễn của PowerPoint, đó 

là các trang trình diễn không chỉ bao gồm các dòng chữ đứng yên buồn tẻ, trái lại chúng có 

thể “nhảy múa” dưới sự điều khiển của người trình diễn cùng với sự phát ra các âm thanh vui 

tai, sinh động. Cụ thể hơn, người dùng có thể đưa vào các hiệu ứng động sao cho lúc trình 

diễn, sau mỗi lần nhấn phím hay kích chuột, các thành phần văn bản lần lượt hiện ra theo 

nhiều kiểu khác nhau: bay ra từ bên trái, từ bên phải, từ trên xuống, dưới lên, theo kiểu xoáy 

trôn ốc... kèm theo nhiều loại âm thanh. 
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Cách thực hiện: 
 

 

 
 

 

 
 

 

chọn cách hiển thị tự 

động hay đợi gõ 

phím/kích nút chuột 

thay đối trình tự hiển 

thị 

chọn thành 

phần của Slide 

để tạo hiệu 

ứng động 

chọn  xem 

trước các 

hiệu ứng 

chọn thẻ 

Effect 

chọn kiểu 

hiệu ứng 
chọn thuộc 

tính của hiệu 

ứng 

chọn kiểu âm thanh 

Chọn 

mục 

Custom 

Animation Chọn Side 

Show trên 

thanh Menu 
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11.2 Hiệu ứng chuyển tiếp giữa các trang 

Các hiệu ứng động cũng có thể được đưa vào để chuyển tiếp giữa các trang lúc trình diễn.  

Cách thực hiện: 

+ Chọn Slide Show -> Slide Transition trên thanh Menu 
 

 

 
 

 

 

12. Tạo nội dung chân trang (footer) 

Microsoft Powerpoint cho phép người dùng có thể đưa vào cuối mỗi Slide các thông tin như: 

số hiệu Slide, ngày tháng tạo lập Slide, và tiêu đề chân trang (footer). Tiêu đề chân trang là 

một đoạn văn bản ngắn bất kỳ, thông thường là các thông tin về cá nhân người tạo lập hoặc 

trình diễn Slide, chẳng hạn như họ tên, cơ quan ... 

Chọn việc 

áp dụng 

cho Slide 

hiện tại 
Chọn việc 

áp dụng 

cho tất cả 

các Slide 

Chọn các cách 

chuyển Slide 

Chọn các hiệu ứng 

về âm thanh 

Chọn tốc độ chuyển 

Slide: 

Slow - chậm, 

Medium - vừa, 

Fast - nhanh 
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Cách thực hiện: 

Chọn View -> Header and Footer trên thanh Menu, sau đó làm các bước như hình vẽ sau: 
 

 

 

 

 

 

 
 

 

 

 

 

chọn mục này 

nếu không muốn 

số hiệu  Slide 

trên trang tiêu đề 

Kích 

Apply để 

áp dụng 

cho Slide 

hiện thời 

 

 

 

 

 

 

13. Sử dụng Slide Master 

nơi nhập tiêu đề chân 

trang 

Slide Master là công cụ cho phép tạo định dạng chung cho toàn bộ các trang trình diễn. Các 

định dạng trên Slide Master phải được phân tích và tính toán cẩn thận trước khi thực hiện. 
 

 

 

2. Chọn 

Master 

1. Chọn 

View 3. Chọn Slide Master 
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Slide Master hiển thị như sau: 
 

 

 
 

 

Nên thực hiện những công việc sau trên Slide Master: 
 

 

(1) Chèn một dòng chữ, hình ảnh cần được xuất hiện trên tất cả các trang. 
 

 

(2) Thay đổi phông chữ, độ lớn chữ trên các khuôn dạng văn bản. 
 

 

14. Tạo các nút hành động (Action Button) 

 Nút hành động là nút mà khi được bấm thì sẽ kích họat một hành động nào đó, chẳng 

hạn như chuyển con trỏ về đầu bài trình diễn, về cuối bài trình diễn, chạy một tệp trình 

diễn khác... Sau đây là cách để đưa vào trang hiện tại một nút hành động, có tác dụng 

kích họat mở một tệp trình diễn khác: 
 

 

Chọn 1 nút 

tác động 
Chọn Slide Show 

Chọn Action Button 

Tiêu đề chính 

Các tiêu đề mức 

nhỏ hơn 
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nơi chọn thư mục 

chứa tệp liên kết 

nơi chọn tệp 

liên kết 

Kích vào đây để mở danh sách các 

hành động có thể gán cho nút 

Chọn hành động liên kết 

đến một file trình diễn 

khác để gán cho nút 

Chọn OK để hoàn 

tất việc gán hành 

động cho nút 
Kích vào đây để 

đưa vào hiệu 

ứng âm thanh 

cho nút 
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 Nếu muốn đưa vào nút một dòng chữ làm nhãn cho nút, ví dụ như “OK”, “Chuyển”... 

làm như sau: 

· Kích chuột phải lên nút. 

· Kích chọn Edit Text. 

· Gõ vào dòng nhãn cho nút. 

· Sau khi gõ xong, kích chuột ra vùng Slide bên ngoài nút để kết thúc việc gõ nhãn 

nút. 
 

 

15. Tạo các siêu liên kết (Hyperlink) 

 Để đưa vào một siêu móc nối đến  một trang Web khác, chọn Insert -> Hyper Link 

trên thanh Menu 

 Trong cửa sổ Insert Hyperlink lần lượt điền các tham số sau: 
 

 
 

 

 Các thao tác định dạng chữ của Hyperlink làm tương tự như đối với chữ. 

 Nếu muốn sửa đổi các tham số đối với Hyperlink, kích chuột vào Hyperlink, sau đó 

lặp lại các thao tác hai bước đầu. 
 

 

16. Thực hiện in ấn 

Trước khi in, người dùng cần thay đổi các thông số của trang in như: hướng in, kích thước 

trang in ... nếu không muốn dùng các thông số mặc định. 

1. Gõ văn bản 

hiển thị của 

Hyperlink 

2. Gõ địa chỉ 

trang Web 

móc nối đến 

3. Kích OK để 

kết thúc 
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16.1 Thay đổi các thông số trang in 

Các bước thực hiện như sau: 
 

 

 
 

 

 

 

 
 

 

16.2 In theo trang trình diễn 

 Chọn File -> Print trên thanh Menu 

 Sau đó làm các bước như sau: 
 

 

Chọn in 

tất cả các 

Slide 

Chọn in Slide 

hiện thời 

Chọn số 

lần in lặp 

Bấm chọn mục 

Pure black and 

white để in ra 

bản gốc chỉ có 

màu đen&trắng 

Chọn in từ 

Slide nào đến 

Slide nào 

Chọn hướng in 

theo chiều dọc 

Chọn kiểu 

giấy in Chọn hướng in 

theo chiều dọc 

cho khi in kiểu 

Handout 
Chọn 

hướng in 

theo chiều 

ngang khi 

in  từng 

Slide 

Chọn 

File -> Page Setup 
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16.3 In theo kiểu Handout 

Các thao tác giống như in một Slide trên một trang, ngoại trừ các thao tác sau: 
 

 
 

 

 

 

17. Trình diễn kết quả 
 

17.1 Thao tác với trang trình diễn 

Để trình diễn cần hãy chọn khung nhìn Slide Show, thao tác nhanh bằng phím F5: 
 

 
 

Cách trình diễn như sau: Trong khung nhìn Slide Show, các trang trình diễn được phóng to 

chiếm hết diện tích màn chiếu. Mỗi thời điểm chỉ 1 trang được thực hiện. 

Kích nút này để 

chuyển sang khung 

nhìn Slide Show 

Bấm chọn 

mục Pure 

black and 

white để in 

ra bản gốc 

chỉ có màu 

đen&trắng 

Chọn 

Handout 
2. Chọn số 

Slide in trên 

1 trang 
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Để dịch chuyển tiến lui giữa các trang, người trình diễn dùng 1 số nút bấm hoặc kích chuột: 
 

+ Tiến: kích chuột hoặc bấm phím N hoặc phím PgUp. 
 

+ Lùi: bấm phím P hoặc phím PgDn. 
 

+ Dừng trình diễn: bấm phím Esc. 
 

+ Dịch chuyển đến 1 Slide bất kỳ: 
 

- Kích chuột phải tại vị trí bất kỳ của màn hình đang trình diễn làm xuất hiện hộp chọn. 

Chọn mục Go -> Slide Navigator, sau đó chọn Slide cần chuyển đến rồi kích nút Go 

To. 
 

 

 

+ Thao tác nhanh bằng cách: bấm số trang và bấm phím ENTER. Đây là cách thường được 

sử dụng và có hiệu quả cao. 
 

 

17.2 Sử dụng bút vẽ khi trình diễn 

Microsoft Powerpoint hỗ trợ sẵn công cụ bút vẽ khi trình diễn giúp người trình diễn gạch chân 

những câu cần thiết. 
 

Cách thực hiện: 
 

+ Khi đang ở khung Slide Show, kích nút chuột phải làm xuất hiện hộp thọai và chọn mục 

Pointer Options --> Pen. Con trỏ chuột biến đổi thành dạng bút cho phép viết, vẽ lên trang 

trình diễn. 
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+ Việc xóa bỏ các dấu bút đã viết, vẽ đơn giản như sau: 
 

 
 

+ Muốn con trỏ chuột trở về trạng thái bình thường chỉ cần chọn Pointer Options --> 

Automatic 
 

 

17.3 Trình diễn trang tự động 

Cách thực hiện: 
 

+ Vào thực đơn lệnh Slide Show -> chọn Setup Show làm xuất hiện hộp chọn lựa. 
 

+ Đặt lựa chọn vào mục: Loop continuosly until 'Esc' 
 

 
 

+ Vào thực đơn lệnh Slide Show -> chọn Siled Transition làm xuất hiện hộp chọn lựa. 
 

+ Thiết lập mục Effect theo sở thích và chọn mục Automatically After với thời gian thích 

hợp. Nhấn chọn mục Apply to All để kết thúc. 
 

 


